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Getting started
 WARNING

See the Important safety and product information guide in the product box for product warnings and other 
important information.

1 Connect to a Wi‑Fi® network (Connecting to a Wi‑Fi Network, page 50)(optional).
2 Pair your Bluetooth® phone and headset (Pairing with Your Smartphone, page 29) (optional).
3 Update the maps and software on your device (Product updates, page 50).
4 Acquire GPS signals (Acquiring GPS signals, page 2).
5 Mount the device and connect it to power (Installation, page 4).
6 Adjust the screen brightness (Adjusting the screen brightness, page 3).
7 Navigate to your destination (Starting a route, page 11).

Device Overview

Power button

USB power and data port

microSD® memory card slot

Turning the device on or off
• To turn the device on, press the power button or connect the device to power.
• To put the device in power saving mode, press the power button while the device is on.

While in power saving mode, the screen is off and the device uses very little power, but it can wake instantly 
for use.
TIP: you can charge your device faster by putting it in power saving mode while charging the battery.

• To turn off the device completely, hold the power button until a prompt appears on the screen and select Off.
The prompt appears after five seconds. If you release the power button before the prompt appears, the 
device enters power saving mode.
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Acquiring GPS signals
When you turn on your navigation device, the GPS receiver must collect satellite data and establish the current 
location. The time required to acquire satellite signals varies based on several factors, including how far you are 
from the location where you last used your navigation device, whether you have a clear view of the sky, and how 
long it has been since you last used your navigation device. The first time you turn on your navigation device, it 
may take several minutes to acquire satellite signals.
1 Turn on the device.
2 Wait while the device locates satellites.
3 If necessary, go to an open area away from tall buildings and trees.

 in the status bar indicates the satellite signal strength. When at least half of the bars are filled, the device 
is ready for navigation.

Status bar icons
The status bar is located at the top of the main menu. The status bar icons display information about features 
on the device. You can select some icons to change settings or view additional information.

GPS signal status. Hold to view GPS accuracy and acquired satellite information (Viewing GPS 
signal status, page 63).

Bluetooth technology status. Select to view the Bluetooth settings (Bluetooth settings, page 45).

Wi-Fi signal strength. Select to change the Wi-Fi settings (Wi‑Fi settings, page 46).

Connected to hands-free calling. Select to place a phone call (Hands-free calling, page 31).

Current time. Select to set the time (Setting the Time, page 48).

Battery charge level.

Tread® app connection status (Pairing with Your Smartphone, page 29).

Temperature. Select to view the weather forecast (Viewing the Weather Forecast, page 44).

Fuel status. Select to view fuel tracking information (Fuel tracking, page 17).

Using the on-screen buttons
On-screen buttons allow you to navigate the pages, menus and menu options on your device.
• Select  to return to the previous menu screen.
• Hold  to quickly return to the main menu.
• Select  or  to scroll through lists or menus.
• Hold  or  to scroll faster.
• Select  to see a context-based menu of options for the current screen.
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Adjusting the volume
1 Select .
2 Select an option:

• Use the slider bar to adjust the volume.
• Select  to mute the device.
• Select a tick box to enable or disable additional sound options.

Using the audio mixer
You can use the audio mixer to set the volume levels for different audio types, such as navigation prompts or 
phone calls. The level for each audio type is a percentage of the master volume.
1 Select .
2 Select Audio Mixer.
3 Use the sliders to adjust the volume for each audio type.

Adjusting the screen brightness
1 Select  > Display > Brightness.
2 Use the slider bar to adjust the brightness.

Changing the Keyboard
Before you can change the keyboard language or layout, you must enable a keyboard language or layout in the 
system settings (System Settings, page 48).
• Select  to switch to a different keyboard language or layout.
• Select  or  to view more characters.
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Installation
Mounting your device in a motorcycle

Powered Motorcycle Mount
 WARNING

See the Important safety and product information guide in the product box for product warnings and other 
important information.
Garmin® strongly recommends having an experienced installer with the proper knowledge of electrical systems 
install the device. Incorrectly wiring the power cable can result in damage to the vehicle or the battery and can 
cause bodily injury.

The device must be mounted in a suitable and secure location on your motorcycle, based on available power 
sources and safe cable routing.

Motorcycle mount connector

10 to 30 Vdc system power (red)

System ground (black)

NOTE: additional parts are included with the device to provide more installation and wiring options. Contact an 
experienced installer for more information about using these parts with your motorcycle.
Crimp-Style Ring Terminal: connects the wiring harness directly to the battery terminal.
Cable Tie: secures cables to the motorcycle frame.
In-line Fuse Cable: protects the navigation device from excessive electrical current (In-line Fuse Cable, 

page 5).
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In-line Fuse Cable

 WARNING
Garmin strongly recommends getting an experienced installer with a proper knowledge of electrical systems to 
install the in-line fuse cable. Incorrectly wiring the power cable or the in-line fuse cable can result in damage to 
the vehicle or the battery and can cause bodily injury.

In many cases, you must install the included in-line fuse cable on the device power cable to protect the zūmo 
navigator from excessive electrical current.

• You must install the included in-line fuse cable if you are connecting the power cable directly to the vehicle 
battery.

• If you are connecting the power cable to an accessory power source or bus bar that already has a suitable 
fuse or a protective circuit, installing the included in-line fuse is not necessary.

• When installing the fuse cable, you must connect it to the red system power cable using solder and heat-
shrink tubing.

Installing the Handlebar Base
The device includes parts for two handlebar installation solutions. Custom mounts may require additional 
hardware.

Installing the U-bolt and Handlebar Base
1 Place the U-bolt  around the handlebar , and thread the ends through the handlebar base .

2 Tighten the nuts  to secure the base.
NOTE: the recommended torque is 5.65 N-m (50 lbf-in). Do not exceed a torque of 9.04 N-m (80 lbf-in).
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Installing the Handlebar Base to the Clutch-Clamp or Brake-Clamp Brackets
1 Remove the two factory bolts on your clutch-clamp or brake-clamp bracket .

NOTE: both 1/4 in. standard and M6 bolts are included. Match the size of the factory bolts on your clutch-
clamp or brake-clamp bracket.

2 Thread the new bolts  through the handlebar base, spacers , and clutch-clamp or brake-clamp bracket.
3 Tighten the bolts to secure the handlebar base.

Attaching the Base Plate to the Handlebar Base
1 Align the ball of the handlebar base  and the ball of the base plate  with each end of the double-socket 

arm .

2 Insert the ball of the handlebar base  and the ball of the base plate  into the double-socket arm .
3 Tighten the knob slightly.
4 Adjust for optimal viewing and operation.
5 Tighten the knob to secure the mount.
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Installing your device in the motorcycle mount
1 Fit the bottom of your device into the cradle.

2 Push the top of the device forward until it snaps into place.
The latch  on the mount stays up after you have inserted the device.

Removing Your Device from the Motorcycle Mount
1 Press the latch on the top of the mount.
2 Lift out the device.

Rider Awareness Features and Alerts
 CAUTION

The rider alerts and speed limit features are for information only and do not replace your responsibility to abide 
by all posted speed limit signs and to use safe driving judgement at all times. Garmin is not responsible for any 
traffic fines or citations that you receive for failing to follow all applicable traffic laws and signs.

Your device provides features that can help encourage safer riding, even when you are riding in a familiar area. 
The device plays an audible tone or message and displays information for each alert. You can enable or disable 
the audible tone or message for each type of alert. Not all alerts are available in all areas.
School zone or nearby school: the device plays a tone and displays the distance to and speed limit (if available) 

for an upcoming school or school zone.
Speed limit reduction: the device plays a tone and displays the upcoming reduced speed limit so you can be 

prepared to reduce your speed.
Speeding alert: the device displays a red border on the speed limit icon when you exceed the posted speed limit 

for the current road.
Level crossing: the device plays a tone and displays the distance to an upcoming level crossing.
Animal crossing: the device plays a tone and displays the distance to an upcoming animal crossing area.
Curve: the device plays a tone and displays the distance to a curve in the road.
Slower traffic: the device plays a tone and displays the distance to slower traffic when you approach slower 

traffic at a higher speed. Your device must be receiving traffic information to use this feature (Receiving 
traffic data using your smartphone, page 32).

Break planning: the device plays a tone and suggests upcoming rest stops after you have been driving for more 
than two hours without stopping.
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Enabling or Disabling Rider Alerts
You can turn off individual audible rider alerts. Visual alerts appear even when the audible alert is disabled.
1 Select  > Driver Assistance > Rider Alerts.
2 Select or clear the tick box next to each alert.

Red light and speed cameras
NOTICE

Garmin is not responsible for the accuracy of or the consequences of using a red light or speed camera 
database.

NOTE: this feature is not available for all regions or product models.
Information about red light and speed camera locations is available in some areas for some product models. 
The device alerts you when you approach a reported speed or red light camera.
• In some areas, your device can receive red light and speed camera data while connected to a smartphone 

running the Tread app.
• You can use the Garmin Express™ software (garmin.com/express) or the Tread app to update the camera 

database stored on your device. You should update your device frequently to receive the most up-to-date 
camera information.

Incident Detection and Notifications
 WARNING

The device allows you to send your location to an emergency contact. This is a supplementary feature and 
should not be relied upon as a primary method to obtain emergency assistance. The Tread app does not 
contact emergency services on your behalf.

NOTICE
To use this feature, your device must be connected to the Tread app using Bluetooth technology. You can set 
emergency contacts using the Tread app.

Your zūmo device uses built-in sensors to detect a possible vehicle incident.
• If you set up an emergency contact, the device can send an automated text message to that contact when it 

detects an incident and your vehicle stops moving. This can help alert the contact to your situation if you are 
not able to call or send a message. This feature requires your device to be connected to the Tread app using 
Bluetooth technology and your phone to have an active mobile data connection to send a message.

• If you have not set up an emergency contact, the device automatically displays the nearest address or 
geographic coordinates, if available, when it detects an incident. This feature is helpful if you need to tell 
emergency personnel your location.

• If you have an inReach® satellite communicator connected to your zūmo device, you can manually send an 
SOS when your zūmo device detects an incident.
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Setting Up an Emergency Contact
Before you can set up an emergency contact, you must connect your navigation device to the Tread app (Pairing 
with Your Smartphone, page 29).
The device must have access to the Tread app and to your smartphone phone book during the emergency 
contact setup.
1 From the Tread app on your smartphone, select  > Emergency Assistance > Continue.
2 Read and accept the terms of use.

NOTE: you must accept the terms of use to use this feature.
3 Select Add Emergency Contact.

A list of your smartphone contacts appears.
4 Select a contact.
5 Select Import > Save.
6 Follow the on-screen instructions to inform your contact that you have added them as an emergency 

contact.
NOTE: the incident notification message includes the name or nickname you entered, but it is not sent from 
your phone number. The message is sent using a third-party service, and you should inform your emergency 
contact that the incident message will come from an unknown number.

Cancelling an Incident Notification
When the device detects an incident, a message and a voice prompt inform you that a notification will be sent 
to your emergency contact. A 60-second countdown timer starts when the incident is detected, and the device 
sends the notification automatically when the timer expires. If you do not want to send the notification, you can 
cancel it.

Before the timer expires, select Cancel.

Disabling Incident Notifications
While incident notifications are disabled, the device does not send an SMS notification when it detects an 
incident.
1 Select  > Driver Assistance.
2 Clear the Automatic Incident Detection tick box.

inReach Remote
The inReach remote function allows you to control your inReach satellite communication device (sold 
separately) using your zūmo device. You can send messages, view weather reports, trigger an SOS alert and 
more. Go to buy.garmin.com to purchase an inReach device.

Connecting an inReach Device
1 Bring the inReach device within 3 m (10 ft.) of your zūmo device.
2 On your zūmo device, select  > inReach.
3 Follow the on-screen instructions on your zūmo device to complete the pairing process.
After the pairing process is complete, the inReach and zūmo devices connect automatically when they are 
within range.
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Sending an inReach Message
Before you can send an inReach message using your zūmo device, you must pair it with a compatible inReach 
device (Connecting an inReach Device, page 9).
You can use your device to send inReach messages to your contacts.
1 Select  > inReach > .
2 Select New Message.
3 Select Select Contacts to add one or more contacts.
4 Enter a message.
5 Select Send.

Initiating an SOS Rescue
 WARNING

Before you can initiate an SOS rescue using your zūmo navigator, you must pair it with a compatible inReach 
satellite communicator (Connecting an inReach Device, page 9).

 CAUTION
While the device is in SOS mode, do not turn off or attempt to turn off the inReach satellite communicator. Doing 
so could prevent this feature from operating properly and could delay receipt of assistance in the event of an 
emergency.

1 Select  > inReach.
2 Select .
3 Wait for the SOS countdown.

The device sends a default message to the emergency response service with details about your location.
4 Reply to the confirmation message from the emergency response service.

Your reply lets the emergency response service know that you are capable of interacting with them during 
the rescue.
For the first 10 minutes of your rescue, an updated location is sent to the emergency response service every 
minute. To conserve battery power after the first 10 minutes, an updated location is sent every 10 minutes 
when moving and every 30 minutes when stationary.

Cancelling an SOS Rescue
If you no longer need assistance, you can cancel an SOS rescue after it is sent to the emergency response 
service.

Select Cancel SOS.
Your device transmits the cancellation request. When you receive a confirmation message from the emergency 
response service, the device returns to normal operation.

Viewing Helmet Law Notifications
Helmet law and eye protection notifications may appear on your zūmo device the first time your device acquires 
satellites and when your device approaches a location with motorcycle safety rules.

NOTICE
Garmin recommends that all riders wear helmets for safety. Helmet law notifications are for reference only, are 
subject to change and are not intended to be considered legal advice. Helmet law notifications are available in 
the U.S. and Canada only.

Select the notification to view more details.

10 Rider Awareness Features and Alerts



Searching for Helmet Laws
You can search for helmet laws by state or province.
1 Select  > Helmet Guide.
2 Select a county or province.

Navigating to your destination
Routes
A route is a path from your current location to one or more destinations.
• The device calculates a recommended route to your destination based on the preferences you set, including 

the route calculation mode (Changing the route calculation mode, page 12) and avoidances (Avoiding Delays, 
Tolls and Areas, page 16).

• You can start navigating to your destination quickly using the recommended route, or you can select an 
alternative route (Starting a route, page 11).

• If there are specific roads you need to use or avoid, you can customise the route.
• You can add multiple destinations to a route (Adding a location to your route, page 15).

Starting a route
1 Select Where To?, and search for a location.
2 Select a location.
3 Select an option:

• To start navigating using the recommended route, select Go!.
The device calculates a route to the location and guides you using voice prompts and information on the map 
(Your route on the map, page 13). A preview of the major roads in your route appears at the edge of the map for 
several seconds.
If you need to stop at additional destinations, you can add the locations to your route (Adding a location to your 
route, page 15).

Taking a Route Using Garmin Adventurous Routing™

Your device can calculate adventurous routes that prefer curvy roads, hills and fewer motorways. This feature 
can provide a more enjoyable ride, but it may increase the time or distance to your destination.
1 Select Where To?, and search for a location.
2 Select a location.
3 Select .
4 Use the slider to increase or decrease the level of adventure of your route.
5 Select Go!.

Changing Adventurous Route Settings
You can add and remove some types of paths, roads and environmental features from adventurous routes.
1 Select Where To? and search for a location.
2 Select a location.
3 Select  > .
4 Select or remove one or more route features, and select .
The navigator recalculates the route with the selected route features.
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Changing the route calculation mode
1 Select  > Navigation > Calculation Mode.
2 Select an option:

• Select Turn-by-Turn to calculate routes on streets and trails.
• Select Straight Line to calculate point-to-point routes (without roads).

Starting a route by using the map
You can start a route by selecting a location from the map.
1 Select View Map.
2 Drag and zoom the map to display the area to search.
3 Select an option:

• Select a location marker.
• Select a point, such as a street, junction or address location.

4 Select Go!.

Going home
The first time you start a route home, the device prompts you to enter your home location.
1 Select Where To? > Go Home.
2 If necessary, enter your home location.

Editing your home location
1 Select Where To? >  > Set Home Location.
2 Enter your home location.
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Your route on the map
As you travel, the device guides you to your destination using voice prompts and information on the map. 
Instructions for your next turn or exit, or other actions appear across the top of the map.

Distance to the next action.

Next action in the route. Indicates the next turn, exit, or other action and the lane in which you should 
travel, if available.

Name of the street or exit associated with the next action.

Route highlighted on the map.

Next action in the route. Arrows on the map indicate the location of upcoming actions.

Map tools. Provides tools to show you more information about your route and surroundings.

Name of the road on which you are travelling.

Vehicle speed.
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Active lane guidance
As you approach some turns, exits, or interchanges in your route, a detailed simulation of the road appears 
beside the map, if available. A coloured line  indicates the proper lane for the turn.

Viewing turns and directions
While navigating a route, you can view next turns, lane changes, or other directions for your route.
1 From the map, select an option:

• To view next turns and directions as you navigate, select  > Turns.
The map tool displays the next several turns or directions beside the map. The list updates automatically 
as you navigate the route.

• To view the complete list of turns and directions for the entire route, select the text bar at the top of the 
map.

2 Select a turn or direction (optional).
Detailed information appears. An image of the junction may appear for junctions on major roads, if available.

Viewing the Entire Route on the Map
1 While navigating a route, select anywhere on the map.
2 Select .

Arriving at your destination
When you approach your destination, the device provides information to help you complete your route.
•  indicates the location of your destination on the map, and a voice prompt announces you are approaching 

your destination.
• When you approach some destinations, the device automatically prompts you to search for parking. You can 

select Yes to find nearby parking areas (Parking Near Your Destination, page 15).
• When you stop at your destination, the device automatically ends the route. If the device does not detect your 

arrival automatically, you can select Stop to end your route.
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Parking Near Your Destination
Your device can help you find a parking spot near your destination. When you approach some destinations, the 
device automatically suggests parking areas.
1 Select an option:

• When the device suggests parking, select More to see all suggested parking areas.
NOTE: when you select a suggested parking area, the device automatically updates your route.

• If the device does not suggest parking locations, select Where To? > Categories > Parking, and select  > 
My Destination.

2 Select a parking location and select Go!.
The device guides you to the parking area.

Ride Summary
When you arrive at your destination, the device displays a summary of your ride statistics. You can select Save 
to save the ride as a track.
NOTE: you can disable the ride summary in the settings menu (Driver Assistance Settings, page 47).

Changing Your Active Route

Adding a location to your route
Before you can add a location to your route, you must be navigating a route (Starting a route, page 11).
You can add locations to the middle or end of your route. For example, you can add a petrol station as the next 
destination in your route.
TIP: to create complex routes with multiple destinations or scheduled stops, you can use the route planner to 
plan, schedule and save a route (Planning a Route, page 42).
1 From the map, select  > Where To?.
2 Search for a location.
3 Select a location.
4 Select Go!.
5 Select an option:

• To add the location as the next destination in your route, select Add as Next Stop.
• To add the location to the end of your route, select Add as Last Stop.
• To add the location and edit the order of destinations in your route, select Add to Active Route.

The device re-calculates the route to include the added location and guides you to the destinations in order.

Shaping Your Route
Before you can shape your route, you must start a route (Starting a route, page 11).
You can manually shape your route to change its course. This allows you to direct the route to use a certain 
road or go through a certain area without adding a destination to the route.
1 Select anywhere on the map.
2 Select Shape Route.

TIP: you can select  to zoom in on the map and select a more precise location.
The device enters route-shaping mode and recalculates the route to travel through the selected location.

3 Select Go!.
4 If necessary, select an option:

• To add more shaping points to the route, select additional locations on the map.
• To remove a shaping point, select the shaping point and select Remove.
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Taking a detour
You can take a detour for a specified distance along your route or detour around specific roads. This is useful if 
you encounter construction zones, closed roads or poor road conditions.
1 From the map, select  > Edit Route.
2 Select an option:

• To re-route for a specific distance, select Detour by Distance.
• To detour around a specific road on the route, select Detour by Road.

Stopping the route
From the map, select  > Stop.

Avoiding Delays, Tolls and Areas

Avoiding traffic delays on your route
Before you can avoid traffic delays, you must be receiving traffic information (Receiving traffic data using your 
smartphone, page 32).
By default, the device optimises your route to avoid traffic delays automatically. If you have disabled this option 
in the traffic settings (Traffic Settings, page 47), you can view and avoid traffic delays manually.
1 While navigating a route, select  > Traffic.
2 Select Alternative Route, if available.
3 Select Go!.

Avoiding toll roads
Your device can avoid routing you through areas that require tolls, such as toll roads, toll bridges, or congestion 
areas. The device may still include a toll area in your route if no other reasonable routes are available.
1 Select  > Navigation > Avoidances > Tolls and Fees.
2 Select Save.

Avoiding road features
1 Select  > Navigation > Avoidances.
2 Select the road features to avoid on your routes and select Save.

Custom Avoidances
Custom avoidances allow you to select specific areas or sections of road to avoid. When the device calculates a 
route, it avoids these areas and roads unless no other reasonable route is available.

Avoiding an area
1 Select  > Navigation > Custom Avoidances.
2 If necessary, select Add Avoidance.
3 Select Add Avoid Area.
4 Select the upper left corner of the area to avoid and select Next.
5 Select the lower right corner of the area to avoid and select Next.

The selected area is shaded on the map.
6 Select Done.
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Avoiding a road
1 Select  > Navigation > Custom Avoidances.
2 If necessary, select Add Avoidance.
3 Select Add Avoid Road.
4 Select the starting point of the section of road to avoid and select Next.
5 Select the ending point of the road section and select Next.
6 Select Done.

Disabling a custom avoidance
You can disable a custom avoidance without deleting it.
1 Select  > Navigation > Custom Avoidances.
2 Select a created avoidance.
3 Select  > Disable.

Deleting custom avoidances
1 Select  > Navigation > Custom Avoidances > .
2 Select an option:

• To delete all custom avoidances, select Select All > Delete.
• To delete one custom avoidance, select the avoidance and select Delete.

Navigating off road
If you are not following roadways as you navigate, you can use Straight Line mode.

Select  > Navigation > Calculation Mode > Straight Line > Save.
The device ignores roads and calculates routes using straight lines between destinations.

Fuel tracking
You can set your device to estimate your fuel usage, warn you when you approach the maximum estimated 
fuel distance, and suggest fuel stops based on your estimated fuel range. When fuel tracking is enabled, 
indicates the current fuel status.
White: fuel tracking is disabled, or the device is not connected to the motorcycle mount.
Green: the estimated fuel range is above the fuel tank warning level.
Yellow: the estimated fuel range is below the fuel tank warning level.
Red: the estimated distance remaining on the tank is 0.

Enabling fuel tracking
Before you can enable fuel tracking, the device must be placed in the motorcycle mount.
When you enable fuel tracking, a fuel gauge appears on the trip computer (Viewing the trip information page, 
page 27).
1 Fill your fuel tank.
2 Select  > Fuel Settings > Fuel Tracking.
3 Select Distance Per Tank.
4 Enter the distance the vehicle travels on a tank of fuel and select Done.
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Setting a low-fuel warning
You can set the device to warn you when the tank is low on fuel.
NOTE: the device must be connected to the motorcycle mount to give low-fuel warnings.
1 Enable fuel tracking (Enabling fuel tracking, page 17).
2 Select Remaining Fuel Warning.
3 Enter a distance and select Done.
When you have only enough fuel left to travel the distance you entered, a low-fuel warning appears on the map 
page.

Resetting the Fuel Tank Mileage
When you refill your fuel tank, you should reset the fuel tank mileage on your device to more accurately track 
your remaining fuel.

Select  > Fuel Settings > Reset Fuel Tank.

Enabling dynamic fuel stops
Before you can enable dynamic fuel stops, the device must be in motorcycle mode, placed in the motorcycle 
mount and fuel tracking must be enabled.
You can set the device to suggest fuel stops based on your estimated fuel range.

Select  > Fuel Settings > Dynamic Fuel Stops.

Finding and saving locations
The maps loaded in your device contain locations, such as restaurants, hotels, vehicle services, and detailed 
street information. The Where To? menu helps you find your destination by providing several methods to 
browse, search, and save this information.
• Enter search terms to quickly search all location information (Finding a location using the search bar, 

page 19).
• Browse or search pre-loaded points of interest by category (Points of Interest, page 19).
• Use search tools to find specific locations, such as addresses, junctions, or geographic coordinates (Search 

tools, page 22).
• Search near a different town or area (Changing the search area, page 22).
• Save your favourite locations to find them quickly in the future (Saving Locations, page 24).
• Return to recently found locations (Viewing history, page 23).
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Finding a location using the search bar
You can use the search bar to search for locations by entering a category, brand name, address or town name.
1 Select Where To?.
2 Select Search in the search bar.
3 Enter all or part of the search term.

Suggested search terms appear below the search bar.
4 Select an option:

• To search for a type of business, enter a category name (for example, "cinemas").
• To search for a business name, enter all or part of the name.
• To search for an address near you, enter the house number and street name.
• To search for an address in another town, enter the house number, street name, town and county.
• To search for a town, enter the town and county.
• To search for coordinates, enter latitude and longitude coordinates.

5 Select an option:
• To search using a suggested search term, select the term.
• To search using the text you entered, select .

6 If necessary, select a location.

Points of Interest
NOTICE

You are responsible for understanding and complying with any applicable rules, laws or regulations associated 
with points of interest.

A point of interest is a place that you may find useful or interesting. Points of interest are organised by category 
and can include popular travel destinations such as petrol stations, restaurants, hotels, and entertainment 
venues.

Finding a location by category
1 Select Where To?.
2 Select a category or select Categories.
3 If necessary, select a subcategory.
4 Select a location.

Navigating to points of interest within a venue
NOTE: this feature may not be available in all areas or for all product models.
You can create a route to a point of interest (POI) within a larger venue, such as a store in a shopping centre or a 
specific terminal in an airport.
1 Select Where To? > Search.
2 Select an option:

• To search for the venue, enter the name or address of the venue, select , and go to step 3.
• To search for the POI, enter the name of the POI, select , and go to step 5.

3 Select the venue.
A list of categories appears below the venue, such as restaurants, car hire, or terminals.

4 Select a category.
5 Select the POI, and select Go!.
The device creates a route to the parking area or venue entrance closest to the POI. When you arrive at the 
destination, a chequered flag indicates the recommended parking area. A labelled point indicates the location of 
the POI within the venue.
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Exploring a venue
NOTE: this feature may not be available in all areas or for all product models.
You can view a list of all points of interest located within each venue.
1 Select a venue.
2 Select  > Explore this Venue.

Viewing Your Garmin Explore™ Waypoints
1 Select  > Explore.
2 Select a data type.
3 Select an item to view the details.

Synchronising Garmin Explore Account Data
Before you can synchronise account data, you must connect to the Tread app and enable Garmin Explore.
You can synchronise data, such as tracks, with your Garmin Explore account. This can be helpful to keep 
your data available on each of your compatible devices. Your device periodically synchronises data with your 
account automatically. You can also synchronise data manually at any time.
1 Select  > Explore.
2 Select .

Location Search Results
By default, the location search results appear in a list, with the nearest location at the top. You can scroll down 
to view more results.
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Select a location to view the option menu.

 Select to view detailed information about the selected location.

 Select to start navigating to the location using Garmin Adventurous Routing.

 Go! Select to start navigating to the location using the recommended route.

 Select to view the search results on the map.

Location Search Results on the Map
You can view the results of a location search on the map instead of in a list.
From the location search results, select . The nearest location appears at the centre of the map, and basic 
information about the selected location appears at the bottom of the map.

Drag the map to view additional search results.

Additional search results. Select to view another location.

Selected location summary. Select to view detailed information about the selected location.

 Go! Select to start navigating to the location using the recommended route.

 Select to view the search results in a list.
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Changing the search area
By default, the device searches for locations near your current location. You can also search other areas, such 
as near your destination, near another city, or along your active route.
1 Select Where To?.
2 Select  next to the current search area .

3 Select a search area.
4 If necessary, follow the on-screen instructions to select a specific location.
The selected search area appears next to . When you search for a location using any of the options in the 
Where To? menu, the device suggests locations near this area first.

Parking

Finding Parking Near Your Current Location
1 Select Where To? > Categories > Parking.
2 Select a parking location.
3 Select Go!.

Finding Parking Near a Specified Location
1 Select Where To?.
2 Search for a location.
3 From the location search results, select a location.
4 Select  > Parking.

A list of parking areas near the selected location appears.
5 Select a parking location.
6 Select Go!.

Search tools
Search tools allow you to search for specific types of locations by responding to on-screen prompts.

Finding an address
NOTE: the order of the steps may change depending on the map data loaded on your device.
1 Select Where To?.
2 If necessary, select  to search near a different town or area.
3 Select Address.
4 Follow the on-screen instructions to enter address information.
5 Select the address.

Finding a junction
You can search for a junction between two streets, motorways, or other roads.
1 Select Where To? > Junctions.
2 Follow the on-screen instructions to enter street information.
3 Select the junction.
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Finding a location using coordinates
You can find a location using latitude and longitude coordinates.
1 Select Where To? > Coordinates.
2 If necessary, select  and change the coordinate format or datum.
3 Enter the latitude and longitude coordinates.
4 Select View on Map.

Tripadvisor®

NOTICE
Garmin is not responsible for the accuracy or timeliness of the Tripadvisor information.
You are responsible for understanding and complying with any applicable rules, laws or regulations associated 
with points of interest.

Your device includes Tripadvisor traveller ratings. Tripadvisor ratings appear automatically in the search results 
list for restaurants, hotels and attractions. You can also search for nearby Tripadvisor points of interest and sort 
by distance or popularity.

Finding Tripadvisor points of interest
1 Select Where To? > Tripadvisor.
2 Select a category.
3 If necessary, select a subcategory.

A list of nearby Tripadvisor points of interest for the category appears.
4 Select Sort Results to filter the displayed points of interest by distance or popularity (optional).
5 Select , and enter a search term (optional).

Trendy Places
NOTICE

Garmin is not responsible for the accuracy or timeliness of the Tripadvisor or Michelin® information. You are 
responsible for understanding and complying with any applicable rules, laws or regulations associated with 
points of interest.

The Trendy Places search feature includes both Tripadvisor and Michelin points of interest and ratings, 
providing a comprehensive list of attractions. You can filter the search results by categories, ratings and 
distance from the route.
NOTE: Tripadvisor and Michelin points of interest are not available in all areas.

Viewing history
Your device stores a history of the last 50 locations you have found.

Select Where To? > History.

Clearing the list of recently found places
Select Where To? > History >  > Clear > Yes.

Viewing current location information
You can use the Where Am I? page to view information about your current location. This feature is helpful if you 
need to tell emergency personnel your location.

From the map, select the vehicle.
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Finding emergency services and fuel
You can use the Where Am I? page to find the nearest hospitals, police stations, and fuel stations.
1 From the map, select the vehicle.
2 Select Hospitals, Police Station, or Petrol Stations.

NOTE: some service categories are not available in all areas.
A list of locations for the selected service appears, with the nearest locations at the top.

3 Select a location.
4 Select an option:

• To navigate to the location, select Go!.
• To view the phone number and other location details, select .

Getting directions to your current location
If you need to tell another person how to get to your current location, your device can give you a list of 
directions.
1 From the map, select the vehicle.
2 Select  > Directions to Me.
3 Select a starting location.
4 Select Select.

Adding a shortcut
You can add shortcuts to the Where To? menu. A shortcut can point to a location, a category, or a search tool.
The Where To? menu can contain up to 36 shortcut icons.
1 Select Where To? > Personalise.
2 Select an item.

Removing a shortcut
1 Select Where To? >  > Remove Shortcut(s).
2 Select a shortcut to remove.
3 Select the shortcut again to confirm.
4 Select Done.

Saving Locations

Saving a location
1 Search for a location (Finding a location by category, page 19).
2 From the search results, select a location.
3 Select  > Save.
4 If necessary, enter a name, and select Done.
5 Select Save.
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Saving a Location by Using the Map
You can save a location by selecting a location from the map.
1 Select View Map.
2 Drag and zoom the map to display the area to search.
3 Select a point, such as a street, junction or address location.
4 Select Save.
5 Select one or more options:

• To change the name of a location, select Name, and enter a name.
• To change the location marker, select Map Symbol.
• To assign a collection category, select Collections.

6 Select Done.

Saving your current location
1 From the map, select the vehicle icon.
2 Select Save.
3 Enter a name and select Done.
4 Select Save > OK.

Editing a Saved Location
1 Select Where To? > Favourites.
2 If necessary, select a category.
3 Select a location.
4 Select .
5 Select  > Edit.
6 Select an option:

• Select Name.
• Select Phone Number.
• Select Categories to assign categories to the saved location.
• Select Change Map Symbol to change the symbol used to mark the saved location on a map.

7 Edit the information.
8 Select Done.

Deleting a favourite location
NOTE: deleted locations cannot be recovered.
1 Select Where To? > Favourites.
2 Select  > Delete Favourite(s).
3 Select the box next to the saved locations to delete and select Delete.
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Using the Map
You can use the map to navigate a route (Your route on the map, page 13) or to view a map of your surroundings 
when no route is active.
1 Select View Map.
2 Touch anywhere on the map.
3 Select an option:

• Drag the map to pan left, right, up, or down.
• To zoom in or out, select  or .
• To switch between North Up and 3-D views, select .
• To filter the displayed points of interest by category, select .
• To start a route, select a location on the map, and select Go! (Starting a route by using the map, page 12).

Map tools
Map tools provide quick access to information and device functions while you view the map. When you activate 
a map tool, it appears in a panel at the edge of the map.
Stop: stops navigation of the active route.
Edit Route: allows you to re-route or skip locations in your route (Changing Your Active Route, page 15).
Mute: mutes the device audio.
Towns Ahead: displays upcoming towns and services along your active route or along a motorway.
Up Ahead: displays upcoming locations along the route, or the road on which you are travelling (Up ahead, 

page 26).
Elevation: displays upcoming elevation changes.
Traffic: displays traffic conditions along your route or in your area (Viewing upcoming traffic, page 28). This 

feature is not available in all areas or for all device models.
Trip Data: displays customisable trip data, such as speed or mileage (Viewing trip data from the map, page 27).
Track Recorder: displays the track data for your active track.
Turns: displays a list of upcoming turns in your route (Viewing turns and directions, page 14).
Phone: displays a list of recent phone calls from your connected phone and displays in-call options while a 

phone call is active.
Weather: displays weather conditions for your area.
Music Player: displays media controls and media information.
Group Ride: displays the distance and direction of the members in your group ride (Group Ride, page 33).
Radio: allows you to use the push-to-talk feature with a compatible Bluetooth headset (Enabling Push-to-Talk 

with a Headset, page 36).

Viewing a map tool
1 From the map, select .
2 Select a map tool.

The map tool appears in a panel at the edge of the map.
3 When you have finished using the map tool, select .

Up ahead
The Up Ahead tool provides information about upcoming locations along your route or the road on which you 
are travelling. You can view upcoming points of interest by category, such as restaurants, fuel stations or 
roadside services.
You can customise three categories to show in the Up Ahead tool.
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Viewing upcoming locations
1 From the map, select  > Up Ahead.

While you are travelling, the map tool shows the next location along your road or route.
2 Select an option:

• If the map tool shows categories, select a category to view a list of nearby locations in that category.
• If the map tool shows upcoming locations, select a location to view location details or start a route to the 

location.

Customising the up ahead categories
You can change the location categories that appear in the Up Ahead tool.
1 From the map, select  > Up Ahead.
2 Select a category.
3 Select .
4 Select an option:

• To move a category up or down in the list, select and drag the arrow next to the category name.
• To change a category, select the category.
• To create a custom category, select a category, select Custom Search and enter the name of a business 

or category.
5 Select Save.

Towns Ahead
While you are travelling on a highway or navigating a route that includes a highway, the Towns Ahead tool 
provides information about upcoming towns along the highway. For each town, the map tool shows the 
distance to the highway exit and the services available, similar to the information on highway road signs.

Viewing Upcoming Towns and Exit Services
1 From the map, select  > Towns Ahead.

While you are travelling along a motorway or an active route, the map tool shows information about 
upcoming towns and exits.

2 Select a town.
The device shows a list of points of interest located at the selected town exit, such as fuel stations, lodging 
or restaurants.

3 Select a location, and select Go! to start navigating.

Trip information

Viewing trip data from the map
From the map, select  > Trip Data.

Customising the trip data fields
1 From the map, select  > Trip Data.
2 Select a trip data field.
3 Select an option.

The new trip data field appears in the trip data map tool.

Viewing the trip information page
The trip information page displays your speed and provides statistics about your trip.

From the map, select Speed.
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Resetting trip information
1 From the map, select Speed.
2 Select  > Reset Field(s).
3 Select an option:

• When not navigating a route, select Select All to reset every data field on the first page except the 
speedometer.

• Select Reset Overall Data to reset the information on the trip computer.
• Select Reset Max. Speed to reset the maximum speed.
• Select Reset Trip B to reset the odometer.

Viewing upcoming traffic
NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Before you can use this feature, your device must be receiving traffic data (Traffic, page 32).
You can view traffic incidents coming up along your route or along the road on which you are travelling.
1 While navigating a route, select  > Traffic.

The nearest upcoming traffic incident appears in a panel on the right side of the map.
2 Select the traffic incident to view additional details.

Viewing traffic on the map
The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select  > Traffic.
2 If necessary, select  > Legend to view the legend for the traffic map.

Searching for traffic incidents
1 From the main menu, select  > Traffic.
2 Select  > Incidents.
3 Select an item in the list.
4 If there is more than one incident, use the arrows to view additional incidents.

Customising the map

Customising the map layers
You can customise which data appears on the map, such as icons for points of interest and road conditions.
1 Select  > Map Display > Map Layers.
2 Select the layers to include on the map, and select Save.

Viewing Popular Motorcycle Paths on the Map
You can enable the device to highlight popular motorcycle paths on the map. This can help you choose roads 
that provide a more enjoyable ride.

From the map, select  > Popular Paths (Moto).

Changing the map data field
1 From the map, select a data field.

NOTE: you cannot customise Speed.
2 Select a type of data to display.
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Changing the Map Buttons
1 From the map, hold a map button.
2 Select an option:

• To replace a map button, select a map button and select a map button to display.
• To remove a map button, select .

3 Select Save.

Changing the map perspective
1 Select  > Map Display > Driving Map View.
2 Select an option:

• Select Track Up to display the map in two dimensions (2-D), with your direction of travel at the top.
• Select North Up to display the map in 2-D with north at the top.
• Select 3-D to display the map in three dimensions.

3 Select Save.

Live services, traffic and smartphone features
 WARNING

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

NOTICE
Garmin is not responsible for the accuracy or timeliness of the traffic information.

The Tread app allows your device to receive smart notifications and live information, such as live traffic data 
and weather information.
Live traffic data: sends live traffic data to your device, such as traffic incidents and delays, construction zones 

and road closings (Traffic, page 32).
Weather information: sends real-time weather forecasts, road conditions and weather radar to your device 

(Viewing the Weather Forecast, page 44).
Smart Notifications: displays phone notifications and messages on your device. This feature is not available for 

all languages.
Hands-Free calling: allows you to place and receive phone calls through the device using your connected 

Bluetooth headset.
Send locations to device: allows you to send locations from your smartphone to your navigation device.

Pairing with Your Smartphone
You can pair your zūmo navigator with your smartphone and the Tread app to enable additional features and 
access live information (Live services, traffic and smartphone features, page 29).
1 Turn on your zūmo navigator, and place the navigator and your smartphone within 3 m (10 ft.) of each other.
2 From your zūmo navigator, select  > Phone > Add a Phone.
3 Using your phone, scan the QR code to download and install the Tread app.

TIP: you can use the camera app on most phones to scan the QR code.
4 Follow the on-screen instructions to sign in to a Garmin account and complete the pairing and setup 

process.
The main app dashboard appears. After the devices are paired, you can enable or disable smartphone features 
on your navigator (Phone Settings, page 45). The devices connect automatically when they are turned on and 
within range.
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Pairing a wireless headset
NOTE: only one headset can receive navigation prompts and phone calls at a time. Up to two headsets can be 
used for multimedia audio.
1 Place your headset and your navigation device within 10 m (33 ft.) of each other.
2 On your navigation device, select  > Headphone > Add Headset.
3 On your headset, enable Bluetooth wireless technology and make it visible to other Bluetooth devices.
4 Follow the on-screen instructions on your navigation device to complete the pairing process.
After the pairing process is complete, you can enable or disable features for your paired wireless headset 
(Headset Settings, page 46).

Smart Notifications
While your device is connected to the Tread app, you can view notifications from your smartphone on your 
zūmo device, such as text messages, incoming calls, and calendar appointments.
NOTE: you may need to wait a few minutes to receive notifications on your navigation device after it connects to 
the Tread app.  appears coloured in the Bluetooth settings when smart notifications are connected and active.

Receiving notifications
 WARNING

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Tread app 
(Pairing with Your Smartphone, page 29).
From most pages, a pop-up appears when the device receives a notification from your smartphone. If the device 
is moving, you must verify you are a passenger and not the driver before you can view notifications.
NOTE: if you are viewing the map, notifications appear in a map tool.
• To ignore a notification, select OK.

The pop-up closes, but the notification remains active on your phone.
• To view a notification, select View.
• To listen to the notification, select View > Play.

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.

• To perform additional actions, such as dismissing the notification from your phone, select View, and select 
an option.
NOTE: additional actions are available for only some notification types and must be supported by the app 
generating the notification.
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Receiving notifications while viewing the map

 WARNING
Do not read or interact with notifications while driving, because doing so can cause distraction that could lead 
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Tread app 
(Pairing with Your Smartphone, page 29).
When you are viewing the map, new notifications appear in a map tool at the edge of the screen. If the device is 
moving, you must verify you are a passenger and not the driver before you can view notifications.
• To ignore a notification, select  or wait for the pop-up to expire.

The pop-up closes, but the notification remains active on your phone.
• To view a notification, select the notification text.
• To listen to the notification, select Play Message.

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.

Viewing the list of notifications
You can view a list of all active notifications.
1 Select  > Smart Notifications.

The list of notifications appears. Unread notifications appear black, and previously read notifications appear 
grey.

2 Select an option:
• To view a notification, select the notification description.
• To listen to a notification, select .

The device reads the notification using text-to-speech technology. This feature is not available for all 
languages.

Hands-free calling
NOTE: while most phones and headsets are supported and can be used, a particular phone or headset cannot 
be guaranteed to be compatible. All features may not be available for your phone.
Using Bluetooth wireless technology, your device can connect to your compatible mobile phone and wireless 
headset or helmet to become a hands-free device. To check compatibility, go to www.garmin.com/bluetooth.

Placing a call
1 Select  > Phone.
2 Select an option:

• To dial a number, select Dial, enter the phone number and select Dial.
• To view numbers of recent, missed or recently dialled or received calls, select Call History, select a log, 

select a number and select Call to dial it.
• To call a contact from your phone book, select Phone Book, select a contact and select Call.
• To call a point of interest location such as a restaurant or attraction, select Browse Categories, select a 

category, select a location and select Call.

Calling home
Before you can call home, you must enter a phone number for your home location.

Select  > Phone > Call Home.
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Placing a Call Using Voice Dial
1 Select  > Phone > Voice Dial.
2 Listen for the voice prompt.
3 Say Call and say the contact name, phone number or location you want to call.

Using in-call options
In-call options are available when you answer a call. Some options may not be compatible with your phone.
TIP: if you close the in-call options page, you can open it again by selecting  from any screen. You can also 
select the caller from the map.
• To set up a conference call, select Add Call.
• To transfer audio to your phone, select Call in Progress on Navigator.

TIP: you can use this feature if you want to disconnect the Bluetooth connection and remain on the call, or if 
you need privacy.

• To use the dial pad, select Keypad.
TIP: you can use this feature to use automated systems, such as voice mail.

• To mute the microphone, select Mute.
• To hang up, select End Call.

Disconnecting a Bluetooth device
You can temporarily disconnect a Bluetooth device without deleting it from the paired devices list. The 
Bluetooth device can connect to your zūmo navigator automatically in the future.
1 Select an option:

• To disconnect a phone, select  > Phone.
• To disconnect a headset, select  > Headphone.

2 Select the device to disconnect.
3 Select Disconnect.

Deleting a paired phone
You can delete a paired phone to prevent it from automatically connecting to your device in the future.
1 Select  > Phone.
2 Select the phone and select Forget Device.

Traffic
NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Your device can provide information about traffic on the road ahead or on your route. You can set your device to 
avoid traffic when calculating routes, and to find a new route to your destination if a large traffic delay occurs on 
your active route (Traffic Settings, page 47). The traffic map allows you to browse the map for traffic delays in 
your area.
To provide traffic information, your device must be receiving traffic data.
• All product models can receive subscription-free traffic data using the Tread app.
Traffic data is not available in all areas. For information about traffic coverage areas, go to garmin.com/traffic.

Receiving traffic data using your smartphone
Your device can receive subscription-free traffic data while connected to a smartphone running the Tread app.
1 Connect your device to the Tread app (Pairing with Your Smartphone, page 29).
2 On your zūmo device, select  > Traffic and verify the Traffic check box is selected.
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Viewing traffic on the map
The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select  > Traffic.
2 If necessary, select  > Legend to view the legend for the traffic map.

Searching for traffic incidents
1 From the main menu, select  > Traffic.
2 Select  > Incidents.
3 Select an item in the list.
4 If there is more than one incident, use the arrows to view additional incidents.

Using the apps
Group Ride
The Group Ride app allows you to coordinate rides and communicate with nearby riders using preset text 
messages, live map locations and voice communications. You can pair your zūmo device with the Tread app on 
your smartphone to enable Group Ride tracking features.
Voice communication and preset messaging require a Group Ride accessory, which is not included with all 
product models. The voice communication feature is not available in all areas. Go to garmin.com for more 
information or to purchase a Group Ride accessory.

Starting a Group Ride
You can create a group ride that allows you to choose the group radio channel, view and remove riders who join 
your group ride and set the group ride name. You can create a group ride using a connected Group Ride mount, 
the Tread app, or both.
1 From the main menu, select Group Ride.
2 If necessary, enter your rider name and select Done.
3 Select Start a Group Ride.
4 Select an option:

• To start a group ride with riders that have a Group Ride mount, select Create a Radio Group Ride.
• To start a group ride with riders using the Tread app, select Create a Mobile Group Ride.

5 If necessary, select the radio channel and select Next.
6 Enter the ride name and select Done.

As riders join your group ride, their names appear on the list.
7 Select Start.

The group ride begins after all riders sync with the group ride.

Joining a Group Ride
You can join a nearby group ride that was created by another rider.
1 From the main menu, select Group Ride > Join a Group Ride.
2 Enter the Ride ID and select Done.

Rejoining a Recent Group Ride
You can rejoin any of your ten most-recent group rides.
1 From the main menu, select Group Ride > Recent Group Rides.
2 Select a recent group ride and select Join.
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Adding Riders to a Radio Group Ride
You can add riders to a radio group ride that is already in progress.
1 From the main menu, select  > Group Ride.
2 If necessary, select .
3 Select Add.

As new riders join the group ride, they appear on the list.
4 Select Continue.

Broadcasting a Message
 WARNING

Do not read, send or reply to any messages while driving. If you do so, you could become distracted by the 
display, which could lead to an accident causing personal injury or death.

You can broadcast a preset message to the members in your active group ride that are in range of the VHF 
radio.
1 From the main menu, select Group Ride.
2 If necessary, select .
3 Select Broadcast to Group.
4 Select a preset message and select Send.

Broadcasting a Location
 WARNING

While driving, do not interact with the display to broadcast your location. If you do so, you could become 
distracted by the display, which could lead to an accident causing serious personal injury or death.

You can broadcast a location to the members in your active group ride that are in range of the VHF radio.
1 From the main menu, select Group Ride.
2 If necessary, select .
3 Select Broadcast to Group > Broadcast a Location and select a location.
4 Select Share.

Viewing a Group Ride Notification
 WARNING

Do not read or reply to any notifications while driving. If you do so, you could become distracted by the display, 
which could lead to an accident causing serious personal injury or death.

From most pages, a notification appears when the device receives a broadcasted group ride location or 
message. You can also view group ride notifications in the Group Ride app.
NOTE: when you are viewing the map, new notifications appear in a map tool at the edge of the screen..
1 From the main menu, select Group Ride >  and select a notification.
2 Select Go! to navigate to a shared location.

Exiting a Group Ride
1 From the main menu, select Group Ride.
2 If necessary, select .
3 Select Exit > Yes.
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Group Ride Settings
From the main menu, select Group Ride > .
Edit Rider Name: allows you to set your name that displays during a group ride. This setting is not available 

during an active group ride.
Rider Map Labels: sets the label displayed for each active rider on the map.
Show Tracks on Map: shows the track that each group ride member takes on the map.
Reset Default Settings: allows you to reset all group ride settings to default values. This setting is not available 

during an active group ride.

Radio
NOTE: this feature is not available on all product models.
NOTE: before you can use the Radio app, you must install a Group Ride accessory. Go to garmin.com to 
purchase a Group Ride accessory.
You can use the Radio app to create radio presets, select a radio channel and select squelch codes. To use this 
feature, you must connect the device and the antenna to the Group Ride mount. The zūmo device configures 
radio settings automatically when you join or create a group ride.

Selecting a Preset
NOTE: for some product models, the Radio app is located in the apps menu.
1 From the main menu, select  > Radio.
2 Select an option:

• To move through the available presets, select  or .
• To select a preset from the menu, select Preset.

Selecting a Radio Channel
1 From the main menu, select  > Radio.
2 Select an option:

• To move to a different channel, select  or .
• To select a MURS channel from the menu, select Channel.

Adjusting the Squelch
You can adjust the squelch and change between CTCSS, DCS and Open squelch modes to improve audio quality 
and avoid radio interference in your area.
1 From the main menu, select  > Radio.
2 Select an option:

• To choose a squelch code within the current mode, select  or .
• To adjust the squelch mode, select Open.

Adding a Custom Radio Preset
1 Select  > Radio > Preset > .
2 Select  or  to select a channel and squelch code.
3 Select Save.
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Selecting a Roger Tone
You can select the tone other devices play when you operate your radio.
1 Select  > Radio >  > Roger Tone.
2 Select a roger tone.

The device plays the selected tone.
3 Select Save.

Turning the Radio Off
Select  > Radio >  > Yes.

Enabling Push-to-Talk with a Headset
You can enable push-to-talk controls for use with a compatible Bluetooth headset. This allows you to transmit 
your voice using the voice dial feature on your headset.
1 Select  > Radio >  > Push to Talk Over Headset.
2 If necessary, follow the on-screen instructions to pair your headset with the device.
3 Select Push to Talk Over Headset.
4 Select .

Transmitting Your Voice
Before you can transmit your voice, you must pair your zūmo device with a compatible Bluetooth headset or 
connect the fist microphone.
You can transmit your voice over the radio using the connected fist microphone or a compatible Bluetooth 
headset.

Select an option:
• Hold the push-to-talk button on the side of the connected fist microphone.
• From the main menu, select  > Radio > Push to Talk Over Headset.
• Use the voice dial feature on your connected Bluetooth headset (Enabling Push-to-Talk with a Headset, 

page 36).
TIP: you can press the pause or stop button to manually close the radio.
NOTE: you must enable the Push to Talk Over Headset setting to use this feature (Radio Settings, 
page 36).

Adjusting the Radio Volume
1 Select  > Radio > .
2 Use the slider bars to adjust the volume.

Radio Settings
From the main menu, select  > Radio > .
Push to Talk Over Headset: enables you to transmit your voice using the push-to-talk button on your compatible 

headset.
Roger Tone: sets the roger tone the device plays when you operate your radio.
Reset Default Settings: resets all radio settings and presets to factory default values.
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Garmin PowerSwitch™ App

 Opens the app settings menu

 Enters editing mode to customise the app layout and functions

 Turns off all outputs

 Power buttons Activates each connected output

Displays input voltage

Displays the total amperage of the selected Garmin PowerSwitch device

Displays the device name

Displays Garmin PowerSwitch device tabs and custom layout tabs

Activating a Power Switch
Before you can use the Garmin PowerSwitch app to activate a switch, you must install your Garmin 
PowerSwitch device in your vehicle and pair it with the Garmin PowerSwitch app.

From the Garmin PowerSwitch app, select a power button to turn a switch on or off.

Turning Off All Switches
Select .
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Customising a Button
1 From the Garmin PowerSwitch app screen, select .

The app enters editing mode.
2 Select  on the button you want to customise.
3 Select an option:

• To change the name of the button, select the Button Label field and enter a name.
• To add an icon to the button, select the Icon field and select an icon.
• To change the button colour, select a colour.
• To change the button mode, select a button mode.
• To adjust the intensity of the switch, use the slider.
• To set the button to activate with a control input, select a control input.

4 Select .
5 Select Done.

Assigning a Switch to a Control Input
Before you can use control input functions, you must connect a control input to your Garmin PowerSwitch 
device (Connecting a Control Input, page 58).
You can assign one or more switches to turn on when the Garmin PowerSwitch device receives a signal from a 
control input.
1 Select .
2 Select your Garmin PowerSwitch device.
3 Select a control input.
4 Select one or more switches.

Adding a Custom Layout
You can add a custom layout tab to the Garmin PowerSwitch app. Buttons added to a custom layout can control 
multiple switches at the same time.
1 From the Garmin PowerSwitch app, select .

The device enters editing mode.
2 Select .
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Adding a Button to a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 Select Add Button.
4 On the new button, select .
5 Select an option:

• To change the name of the button, select the Button Label field and enter a name.
• To add an icon to the button, select the Icon field and select an icon.
• To change the button colour, select a colour.

6 Select Add Action.
7 If necessary, select a Garmin PowerSwitch device and a switch.
8 Select an action:

• To set the button to turn the switch on or off with each press, select Toggle.
• To set the button to turn on the switch, select Turn On.
• To set the button to turn off the switch, select Turn Off.

9 Select a button mode:
• To set the button to activate with one touch, select Normal.
• To set the button to activate only while touching the button, select Momentary.
• To set the button to turn on and off repeatedly, select Strobe and select time intervals.

10 If applicable, use the slider to set the brightness of lights.
11 Select .
12 If necessary, select Add Action to add additional actions to the button.

You can add one action for every switch on the Garmin PowerSwitch device.

Arranging Buttons In a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 On the button you want to move, hold  and drag the button to a new location.

Deleting a Custom Layout or Button
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .

The app enters editing mode.
3 Select an option:

• To delete a button, select  on the button you want to delete.
• To delete a layout tab, select  on the layout tab.

Routines
Routines automate your Garmin PowerSwitch device. When you define a routine on your compatible Garmin 
navigation device, it turns switches on or off automatically when the conditions of the routine are met. For 
example, you can set a routine to turn on a switch at specific time each day or when your vehicle reaches a 
specific speed. Routines are available only when using a compatible Garmin navigation device.
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Adding a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 If necessary, select Add Routine.
3 Select When.
4 Select a trigger:

• To set a switch to trigger when your vehicle reaches a specific speed, select Speed > Next and follow the 
on-screen instructions to enter speed thresholds.

• To set a switch to trigger at a specific time each day, select Time > Next and enter a time.
• To set a switch to trigger at sunrise, select Sunrise.
• To set a switch to trigger at sunset, select Sunset.

5 Select Add Action.
6 Select a device, a switch, an action and a button mode.
7 If necessary, use the slider to adjust the dimmer.
8 Select Save.

Editing a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 Select on the routine you want to edit.
3 Select an option:

• To change the trigger for the routine, select When and select a trigger.
• To change an action, select on the action you want to change and update the action.
• To add an action to the routine, select Add Action and enter information about the action.

4 Select Save.

Deleting a Routine
1 From the Garmin PowerSwitch app, select  > Routines.
2 Select on the routine you want to delete.

Viewing the Owner's Manual on Your Device
You can view the complete owner's manual on the device screen in many languages.
1 Select  > Owner's Manual.

The owner's manual appears in the same language as the software text (System Settings, page 48).
2 Select  to search the owner's manual (optional).

Music Player
The music player can play music or audio from these sources.
• Music files stored on your zūmo device.
• Bluetooth audio from a paired phone.

Adding the Music Player Tool to the Map
The music player map tool enables you to control the music player from your map.
1 Open the map.
2 Select  > Music Player.

The music player controls appear on the map.
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Changing the Media Source
You can change the source from which media is played on your device.
1 Select Music.
2 Select the current media source .

3 Select an available media source from the list.

BirdsEye Imagery
BirdsEye imagery provides downloadable, high-resolution map imagery, including detailed satellite imagery and 
raster-based topographical maps. You can download BirdsEye Satellite Imagery directly to your device when it is 
connected to a Wi‑Fi network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your device, you must connect to a wireless network 
(Connecting to a Wi‑Fi Network, page 50).
1 Select  > BirdsEye Direct.
2 Select .
3 Select an option:

• To download BirdsEye imagery files for a specific location or area, select Location and select a category.
NOTE: the location defaults to your current location.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the downloaded imagery files, select Size and enter a 

distance from the selected location.
• To select where to save the downloaded imagery, select Save to.

4 Select Download.
5 Enter a name for the downloaded imagery and select Done.

Route Planner
You can use the route planner to create and save a route, which you can navigate later. This can be useful for 
planning a delivery route, a vacation, or a road trip. You can edit a saved route to further customise it, including 
reordering locations, adding suggested attractions and adding shaping points.
You can also use the route planner to edit and save your active route.
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Planning a Route
A route can include many locations and it must include at least a starting location and one destination. The 
starting location is the location from which you plan to start your route. If you start navigating the route from 
a different location, the device gives you the option to route to your starting location first. For a round trip, the 
starting location and final destination can be the same.
1 Select  > Route Planner.
2 If necessary, select a calculation mode.

NOTE: the Faster Time mode is selected by default.
3 Select an option to choose a location for your starting point:

• Select a location on the map.
• Select  and search for a location (Finding a location using the search bar, page 19).

4 Repeat step 3 to add more locations.
NOTE: the last location you add is the destination.

5 After you have added all the necessary locations, select .

Editing and Reordering Locations in a Route
1 Select  > Routes.
2 Select a saved route.
3 Select List.
4 Select a location.
5 Select an option:

• To change the location, select , and enter a new location.
• To move the location up or down, select  and drag the location to a new position in the route.
• To add a new location after the selected location, select .
• To remove the location, select .

Changing Routing Options for a Route
You can customise how the device calculates your route.
1 Select  > Routes.
2 Select a saved route.
3 Select .
4 Select an option:

• To add shaping points to your route, select Shaping and select at least one location.
• To change the calculation mode for the route, touch a route segment and select a calculation mode.

Saving Your Active Route
If a route is active, you can use the route planner to save it.
1 Select  > Route Planner.
2 Select  to save your route.

Navigating to a Saved Route
1 Select  > Routes.
2 Select a saved route.
3 Select Go!.
4 Select the first location to navigate to and select OK.
5 Select Start.

The device calculates a route from your current location to the selected location and then it guides you to the 
remaining route destinations in order.
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Sharing a Route
You can share routes with other zūmo navigators.
1 Select  > Explore >  > Share.
2 Select one or more routes and select .
3 Select an option:

• To share a route using the Tread app, select Garmin Tread.
• To copy the route to a microSD card, select Memory Card.

4 Select Done.
5 Follow the on-screen instructions on your zūmo navigator to complete the sharing process.

Tracks
A track is a recording of your path. The track log contains information about the recorded path, including time, 
location, and elevation information.

Recording Tracks
Tracking records your path. When you start tracking, your device logs your location and updates the track. If 
your device is paired with a Garmin Explore account, your device periodically synchronises recorded tracks with 
the app.
1 Select  > Track Recorder.
2 Select Start.

TracBack®

Following your recent track
The TracBack feature records the most recent segment of your movement. You can retrace your recent track 
back to a previous location.
1 Select  > TracBack.

Your recent track appears on the map.
2 Select Go!.

Saving Your Recent Track as a Route
You can save your recent track as a route, which you can navigate later using the route planner (Navigating to a 
Saved Route, page 42).
1 Select  > TracBack.

Your recent track appears on the map.
2 Select  > Save as Route.
3 Enter a name for the route and select Done.
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Viewing the Weather Forecast
NOTICE

Garmin is not responsible for the accuracy or timeliness of the weather data.

Before you can use this feature, your device must be receiving weather data. You can connect your device to the 
Tread app to receive weather data (Pairing with Your Smartphone, page 29).
NOTE: weather forecasts are not available in all areas. 

1 Select  > Weather.
The device shows the current weather conditions and a forecast for the next several days.

2 Select a day.
The detailed forecast for that day appears.

Viewing weather near a different town
1 Select  > Weather > Current Location.
2 Select an option:

• To view weather for a favourite town, select a town in the list.
• To add a favourite town, select Add Town, and enter a town name.

Viewing the weather radar
Before you can use this feature, your device must be connected to a supported phone running the Tread app 
(Pairing with Your Smartphone, page 29).
1 Select  > Weather Radar.
2 Select  to animate the radar map.

Viewing weather alerts
Before you can use this feature, your device must be connected to a supported phone running the Tread app 
(Pairing with Your Smartphone, page 29).
NOTE: this feature is not available in all areas.
While you are travelling with your device, weather alerts may appear on the map. You can also view a map of 
weather alerts near your current location or near a selected town.
1 Select  > Weather.
2 If necessary, select a town.
3 Select  > Weather Alerts.

Checking road conditions
Before you can use this feature, your device must be connected to a supported phone running the Tread app 
(Pairing with Your Smartphone, page 29).
You can view weather-related road conditions for the roads in your area, on your route or in another town.
1 Select  > Weather.
2 If necessary, select a town.
3 Select  > Road Conditions.
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Creating a Round-Trip Route
The device can create a round-trip route using a specified starting location and a distance, duration or 
destination.
1 From the main menu, select  > Round Trip.
2 Select Start Location.
3 Select a location, and select Select.
4 Select Trip Attributes.
5 Select an option:

• Select Choose a Distance to plan your route by distance.
• Select Choose a Duration to plan your route based on time.
• Select Choose a Destination to plan your route based on a specified location.

6 Select Next.
7 Enter a distance, duration or destination.
8 Select an option:

• If you entered a distance or duration, select Done.
• If you selected a destination, select Select.

9 Select Add a Direction.
10 Select a direction and select Next.
11 Select Calculate.
12 Select one or more options:

• Select  to view elevation statistics along your route.
• Select  to shape your route.
• Use the slider to increase or decrease the level of adventure on your route.
• Select , and select one or more route features.

13 Select a route, and select Go!.

Viewing Previous Routes and Destinations
Before you can use this feature, you must enable the travel history feature (Device and privacy settings, 
page 48).
You can view your previous routes and places where you have stopped on the map.

Select  > Where I've Been.

Settings
Bluetooth settings

Phone Settings
Select  > Phone and select your phone.
Disconnect: disconnects the paired phone.
Phone Name: displays the name of the paired phone. You can select the name to change how it displays on 

your navigation device.
Media Audio: enables the navigation device to play media audio from your paired phone.
Garmin Tread: appears when the navigation device is connected to the Tread app on your phone.
Forget Device: removes the connected device from the list of paired devices. This option is available only after a 

device is paired.
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Headset Settings
Select  > Headphone and select your headset.
Disconnect: disconnects the paired headset.
Headset Name: displays the name of the paired headset. You can select the name to change how it appears on 

your navigation device.
Navigation Audio Quality: sets the audio quality for navigation prompts.
Headphone: enables or disables headset features.
Media Audio: enables or disables media audio through the headset.
Forget Device: removes the headset from the list of paired devices.

Wi‑Fi settings
The wireless network settings allow you to manage Wi‑Fi networks.
Select  > Wi-Fi.
Wi-Fi: enables the Wi‑Fi radio.
Saved Networks: allows you to edit or remove saved networks.
Search for Networks: searches for nearby Wi‑Fi networks (Connecting to a Wi‑Fi Network, page 50).

Map Display Settings
Select  > Map Display.
Map Vehicle Icon: sets the vehicle icon that represents your position on the map.
Driving Map View: sets the perspective on the map.
Map Detail: sets the level of detail on the map. More detail may cause the map to be drawn more slowly.
Map Theme: changes the colour of the map data.
Map Layers: sets the data that appears on the map page (Customising the map layers, page 28).
Waypoint Decluttering: hides waypoints at high map zoom levels.
Auto Zoom: automatically selects the zoom level for optimal use of your map. When disabled, you must zoom in 

or out manually.
Skip Next Stop Confirmation: sets a confirmation message to appear when skipping a location on your route.
myMaps: sets which installed maps the device uses.

Enabling maps
You can enable map products installed on your device.
TIP: to purchase additional map products, go to garmin.com/maps.
1 Select  > Map Display > myMaps.
2 Select a map.

Navigation settings
Select  > Navigation.
Calculation Mode: sets the route calculation method.
Off-Route Recalculation: sets recalculation preferences when navigating away from an active route.
Avoidances: sets road features to avoid on a route.
Custom Avoidances: allows you to avoid specific roads or areas.
Traffic: sets options for traffic features.
Environmental Zones: sets the avoidance preferences for areas with environmental or emissions restrictions 

that may apply to your vehicle.
Restricted Mode: disables all functions that require significant operator attention.
GPS Simulator: stops the device from receiving a GPS signal and saves battery power.
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Traffic Settings
From the main menu, select  > Navigation > Traffic.
Traffic: enables traffic.
Optimise Route: enables the device to use optimised alternative routes automatically or upon request (Avoiding 

traffic delays on your route, page 16).
Current Provider: sets the traffic provider to use for traffic data. The Auto option selects the best available 

traffic data automatically.
Subscriptions: lists the current traffic subscriptions.

Setting a simulated location
If you are indoors or not receiving satellite signals, you can use the GPS simulator to plan routes from a 
simulated location.
1 Select  > Navigation > GPS Simulator.
2 From the main menu, select View Map.
3 Tap the map twice to select an area.

The address of the location appears at the bottom of the screen.
4 Select the location description.
5 Select Set Location.

Driver Assistance Settings
Select  > Driver Assistance.
Rider Alerts: allows you to enable or disable alerts for upcoming zones or road conditions (Rider Awareness 

Features and Alerts, page 7).
Speeding Alert: alerts you when you are exceeding the speed limit.
Reduced Speed Tone: alerts you when the speed limit decreases.
Ride Summary: displays a summary of your ride at the end of a route.
Helmet Guide: displays changes for helmet requirements when crossing borders.
Country Border Alert: displays a notification when crossing international borders.
Route Preview: displays a preview of the major roads on your route when you start navigation.
Break Planning: reminds you to take a break, and displays upcoming services after you drive for an extended 

time. You can enable or disable break reminders and upcoming service suggestions.
Automatic Incident Detection: enables the navigator to detect incidents and to notify emergency contacts when 

the navigator detects an incident (Incident Detection and Notifications, page 8).
Incident Messaging: alerts your emergency contacts if an incident is detected (Incident Detection and 

Notifications, page 8).
Proximity Alerts: alerts you when you approach speed cameras or red light cameras.

Display settings
Select  > Display.
Orientation: allows you to set the display to portrait (vertical) or landscape (horizontal).

NOTE: this feature is not available on all product models.
Colour Mode: allows you to select day or night colour mode. If you select the Auto option, the device 

automatically switches to day or night colours based on the time of day.
Brightness: allows you to adjust the display brightness.
Display Timeout: allows you to set the amount of idle time before your device enters sleep mode while using 

battery power.
Screenshot: allows you to take a picture of the device screen. Screenshots are saved in the Screenshot folder of 

the device storage.
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System Settings
Select  > System.
Voice Language: sets the language for voice prompts.
Text Language: sets all on-screen text to the selected language.

NOTE: changing the text language does not change the language of user-entered data or map data, such as 
street names.

Keyboard Language: enables keyboard languages.
Units: sets the unit of measure used for distances.
Current Time: sets the device time.
Time Format: allows you to select a 12-hour, 24-hour or UTC display time.
Position Format: sets the coordinate format and datum used for geographical coordinates.

Setting the Time
1 From the main menu, select the time.
2 Select an option:

• To set the time automatically using GPS information, select Automatic.
• To set the time manually, drag the numbers up or down.

Device and privacy settings
Select  > Device.
About: displays the software version number, the unit ID number and information on several other software 

features.
Regulatory: displays regulatory markings and information.
EULAs: displays the end-user licence agreements.

NOTE: you need this information when you update the system software or purchase additional map data.
Software Licences: displays software licensing information.
Device Data Reporting: shares anonymous data to improve the device.
Travel History: allows the device to store a record of the places you go. This allows you to view the trip log, use 

the Where I've been feature and use myTrends™ suggested routes.
Reset: allows you to clear your travel history, reset settings or delete all user data.

Restoring settings
You can restore a category of settings or all settings to the factory default values.
1 Select .
2 If necessary, select a settings category.
3 Select  > Restore.

Device information
Viewing E-label Regulatory and Compliance Information
1 From the settings menu, swipe to the bottom of the menu.
2 Select Device > Regulatory.
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Specifications
Water resistance IEC 60529 IPX71

Operating temperature range From -15° to 55°C (from 5° to 131°F)

Charging temperature range From 0° to 45°C (from 32° to 113°F)

Power input (vehicle power cable, motorcycle or external power) From 12 to 24 Vdc

Battery type Lithium-ion battery

Battery voltage range From 3.5 to 4.1 V

Wireless frequencies and transmit power
2.4 GHz @ 17.6 dBm maximum
5.1 GHz @ 17.4 dBm maximum
5.2 GHz @ 21.3 dBm maximum

EU SAR 0.1 W/kg torso, 0.17 W/kg limb

Charging the Device
NOTE: this Class III product shall be powered by an LPS power supply.
You can charge the battery in the device using any of these methods.
• Install the device in the mount, and connect the mount to vehicle power.

NOTICE
Do not connect the device directly to the vehicle power cable.
• Connect the device to an optional power adapter accessory, such as a wall power adapter.

You can purchase an approved Garmin AC-DC adapter suitable for home or office use from a Garmin dealer 
or www.garmin.com. The device may charge slowly when connected to a third-party adapter.

Device maintenance
Garmin Support Centre
Go to support.garmin.com for help and information, such as product manuals, frequently asked questions, 
videos and customer support.

Map and Software Updates
For the best navigation experience, you should keep the maps and software on your device up to date.
Map updates provide the newest available changes to roads and locations in the maps used by your device. 
Keeping maps up to date helps your device find recently added locations and calculate more accurate routes. 
Map updates are large and may take several hours to complete.
Software updates provide changes and improvements to the device features and operation. Software updates 
are small and take a few minutes to complete.
You can update your device using two methods.
• You can connect the device to a Wi‑Fi network to update directly on the device (recommended). This option 

allows you to update your device conveniently without connecting it to a computer.
• You can connect the device to a computer and update it using the Garmin Express application (garmin.com

/express).

1 *The device withstands incidental exposure to water of up to 1 m for up to 30 min. For more information, go to www.garmin.com/waterrating.

Device maintenance 49

http://www.garmin.com
http://support.garmin.com
http://www.garmin.com/express
http://www.garmin.com/express
http://www.garmin.com/waterrating


Connecting to a Wi‑Fi Network
The first time you turn on the device, it prompts you to connect to a Wi‑Fi network and register your device. You 
can also connect to a Wi‑Fi network using the settings menu.
1 Select  > Wi-Fi.
2 If necessary, select Wi-Fi to enable Wi‑Fi technology.
3 Select Search for Networks.

The device displays a list of nearby Wi‑Fi networks.
4 Select a network.
5 If necessary, enter the password for the network, and select Done.
The device connects to the network, and the network is added to the list of saved networks. The device 
reconnects to this network automatically when it is within range.

Updating Maps and Software Using a Wi‑Fi Network
NOTICE

Map and software updates may require the device to download large files. Regular data limits or charges from 
your internet service provider apply. Contact your internet service provider for more information about data 
limits or charges.

You can update the maps and software by connecting your device to a Wi‑Fi network that provides access to the 
internet. This allows you to keep your device up to date without connecting it to a computer.
1 Connect the device to a Wi‑Fi network (Connecting to a Wi‑Fi Network, page 50).

While connected to a Wi‑Fi network, the device checks for available updates. When an update is available, 
appears on the  icon in the main menu.

2 Select  > Updates.
The device checks for available updates. When an update is available, Update Available appears below Map 
or Software.

3 Select an option:
• To install all available updates, select Install All.
• To install only map updates, select Map > Install All.
• To install only software updates, select Software > Install All.

4 Read the licence agreements, and select Accept All to accept the agreements.
NOTE: if you do not agree with the licence terms, you can select Reject. This stops the update process. You 
cannot install updates until you accept the licence agreements.

5 Using the included USB cable, connect the device to external power, and select Continue (Charging the 
Device, page 49).
For the best results, a USB wall charger that provides at least 2 A power output is recommended. Many 
USB power adapters for smartphones, tablets or portable media devices may be compatible.

6 Keep the device connected to external power and within range of the Wi‑Fi network until the update process 
is complete.

TIP: if a map update is interrupted or cancelled before it completes, your device may be missing map data. To 
repair missing map data, you must update the maps again using either Wi‑Fi or Garmin Express.

Product updates
On your computer, install Garmin Express (www.garmin.com/express).
This provides easy access to these services for Garmin devices:
• Software updates
• Map updates
• Product registration
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Updating Maps and Software with Garmin Express
You can use the Garmin Express application to download and install the latest map and software updates for 
your device.
1 If you do not have the Garmin Express application installed on your computer, go to garmin.com/express and 

follow the on-screen instructions to install it.
2 Open the  Garmin Express application.
3 Connect your device to your computer using a USB cable.

The small end of the cable connects to the USB port  on your zūmo device, and the large end connects to 
an available USB port on your computer.

4 From your zūmo device, select Tap to Connect to Computer.
5 In the Garmin Express application, click Add a Device.

The Garmin Express application searches for your device and displays the device name and serial number.
6 Click Add Device and follow the on-screen instructions to add your device to the Garmin Express application.

When setup is complete, the Garmin Express application displays the updates available for your device.

7 Select an option:
• To install all available updates, click Install All.
• To install a specific update, click View Details and click Install next to the update you want.
The Garmin Express application downloads and installs the updates onto your device. Map updates are very 
large and this process may take a long time on slower internet connections.
NOTE: if a map update is too large for the internal storage of the device, the software may prompt you to 
install a microSD card in your device to add storage space (Installing a memory card for maps and data, 
page 62).

8 Follow the on-screen instructions during the update process to finish installing updates.
For example, during the update process, the Garmin Express application may instruct you to disconnect and 
reconnect your device.
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Device Care
NOTICE

Avoid dropping your device.
Do not store the device where prolonged exposure to extreme temperatures can occur, as it can cause 
permanent damage.
Never use a hard or sharp object to operate the touchscreen as this may result in damage.

Cleaning the outer casing
NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

1 Clean the outer casing of the device (not the touchscreen) using a cloth dampened with a mild detergent 
solution.

2 Wipe the device dry.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect the device from the power.
4 Gently wipe the screen with the cloth.

Restarting the Device
You can restart your device if it stops functioning.

Hold the power button for 12 seconds.

Removing the Device, Mount and Suction Cup

Removing the Device from the Mount
1 Press the release tab or button on the mount.
2 Tilt the top of the device downwards and lift the device from the mount.

Removing the Mount from the Suction Cup
1 Turn the device mount to the right or left.
2 Apply pressure until the socket on the mount releases the ball on the suction cup.

Removing the Suction Cup from the Windscreen
1 Flip the lever on the suction cup towards you.
2 Pull the tab on the suction cup towards you.

Changing the Fuse in the Fuse Cable
NOTICE

When replacing the fuse, verify that the replacement fuse is fully inserted into the fuse housing. The vehicle 
power cable does not work unless it is assembled correctly.

If your device does not charge in your vehicle, you may need to replace the fuse located on the red system 
power cable.
1 Lift up the cover from the top of the fuse housing.
2 Insert a new 3 A fuse.
3 Replace the cover on the fuse housing.
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Troubleshooting
My device is not acquiring satellite signals
• Verify the GPS simulator is turned off (Navigation settings, page 46).
• Take your device out of multi-storey car parks and away from tall buildings and trees.
• Remain stationary for several minutes.

My battery does not stay charged for very long
• Decrease the screen brightness (Display settings, page 47).
• Shorten the display timeout (Display settings, page 47).
• Decrease the volume (Adjusting the volume, page 3).
• Turn off the Wi-Fi radio when it is not in use (Wi‑Fi settings, page 46).
• Put the device in power saving mode when not in use (Turning the device on or off, page 1).
• Keep your device away from extreme temperatures.
• Do not leave your device in direct sunlight.

My device does not connect to my phone
• Select  > Phone, and verify that your phone is paired with the navigator.
• Enable Bluetooth wireless technology on your phone, and bring your phone within 10 m (33 ft.) of the device.
• Verify your phone is compatible.

Go to www.garmin.com/bluetooth for more information.
• Complete the pairing process again.

To repeat the pairing process, you must unpair your phone and device (Disconnecting a Bluetooth device, 
page 32), and complete the pairing process (Pairing with Your Smartphone, page 29).

The suction cup will not stay on my windscreen
1 Clean the suction cup and windscreen with surgical spirit.
2 Dry with a clean, dry cloth.
3 Mount the suction cup (Mounting Your Device in a Vehicle, page 54).

My device does not appear as either a portable device or a removable drive or 
volume on my computer
1 Disconnect the USB cable from your computer.
2 Turn off the device.
3 Connect the USB cable to your device and to a USB port on your computer.

TIP: the USB cable must connect to a USB port on your computer, not to a USB hub.
The device turns on automatically and goes into MTP mode or USB mass storage mode. A picture of the device 
connected to a computer appears on the device screen.
NOTE: if you have several network drives mapped on your computer, Windows® may have trouble assigning 
drive letters to your Garmin drives. For information about assigning drive letters, see the help file for your 
operating system.
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Appendix
Mounting Your Device in a Vehicle

 WARNING
See the Important safety and product information guide in the product box for product warnings and other 
important information.
This product contains a lithium-ion battery. To prevent the possibility of personal injury or product damage 
caused by battery exposure to extreme heat, store the device out of direct sunlight.
Do not use the suction cup mount on a motorcycle.

NOTICE
Before mounting the device, check the local laws pertaining to windscreen mounting.

NOTE: the vehicle mount is an optional accessory. Go to garmin.com to purchase optional accessories.
1 Plug the automotive power cable  into the port  on the device.

2 Remove the clear plastic from the suction cup .
3 Clean and dry your windscreen and the suction cup with a lint-free cloth.
4 Press the suction cup to the windscreen, and flip the lever  back toward the windscreen.
5 Snap the cradle  onto the suction-cup arm.
6 Fit the top of your device into the cradle.
7 Press the device into the cradle until it snaps into place.
8 Plug the other end of the automotive power cable into a power outlet.

Garmin PowerSwitch
 WARNING

Garmin strongly recommends having an experienced installer with the proper knowledge of electrical systems 
install the device. Incorrectly wiring the power cable can result in damage to the vehicle or the battery and can 
cause bodily injury.

You can use a connected Garmin PowerSwitch device to control lights, fans and more from your zūmo device.

Mounting Considerations
• The device must be mounted close to the battery and within the range of the supplied power cable.
• The mounting surface must be strong enough to support the weight of the device.
• The location must allow room for the routing and connection of all cables.
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Mounting the Device
Before you can mount the device, you must select a mounting location and purchase the appropriate hardware 
for your mounting surface.

NOTICE
Avoid wires, gauges, air bags, air bag covers, heating, ventilation, and air conditioning and other items when 
drilling pilot holes and attaching the mount to the vehicle. Garmin is not responsible for any damages or 
consequences arising from the installation.

1 Place the mount on the selected location.

2 Using the mount as a template, mark the two screw locations .
3 Drill pilot holes (optional).

For some types of mounting material, drilling pilot holes is necessary. Do not drill through the mount.
4 Securely fasten the mount to the surface using the appropriate hardware for your mounting surface.
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Opening the Front Cover
You must open the front cover to make electrical connections.
1 Lift the front cover latch  and rotate it anticlockwise.

2 Pull the front cover off of the device.
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Connecting Accessories
NOTICE

Do not use the device to control or power a winch. Failure to follow this notice could cause damage to your 
vehicle or your device.
Do not connect a power source to an accessory output terminal. Failure to follow this notice could cause 
damage to your vehicle or your device.

Accessory requirements:
• Verify the amperage rating of each accessory before wiring it to the Garmin PowerSwitch device. The device 

supports accessories up to 30 A for each channel and a maximum of 100 A for the entire system.
• Use 10 AWG (6 mm2) wires for accessories that use 20 to 30 A.
• Use 12 AWG (4 mm2) wires for accessories that use 10 to 20 A.
• Use 14 AWG (2.5 mm2) wires for accessories that use less than 10 A.
• Use the appropriate size terminals for all accessory connections.
• Crimp all terminal connectors securely.
1 Connect the positive wire from the accessory  to one of the accessory terminals  on the Garmin 

PowerSwitch device.

2 Connect the negative or ground wire  to an unpainted ground stud  on the vehicle frame, to a ground 
distribution block or directly to the negative terminal on the battery.
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 CAUTION
Do not connect the accessory ground wires to the ground terminal (GND) on the Garmin PowerSwitch device, as 
doing so could result in personal injury or property damage, or could negatively impact device functionality.
3 Verify that all electrical connections are tight and will not come loose during use.

Connecting a Control Input
You can connect to the control terminals to enable the Garmin PowerSwitch device to turn on customisable 
outputs. For example, you can connect your vehicle ignition switch to a control input terminal to turn on 
accessories automatically each time you start your vehicle. The control terminals detect a signal from 3.3 V to 
18 V. You can configure output functions with the Garmin PowerSwitch app.

Connect the control wire from the control source in your vehicle to one of the two control terminals on the 
Garmin PowerSwitch device.

Connecting the Device to Vehicle Power
Before you can connect the device to vehicle power, you must remove the warning tag from the +12V terminal 
on the device.
You should always confirm all electrical connections are secure and will not come loose while operating the 
device.
1 Connect the large ring end of the included ground wire  to the negative terminal on the vehicle battery.

2 Connect the small ring end of the ground wire to the GND terminal  on the device.
3 Connect the small ring end of the included 12-V cable to the +12V terminal  on the device.
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4 Tighten the 3/8 in. nut on the +12V terminal to a maximum torque specification of 4.52 N-m (40 lbf-in.).
You should confirm the nut cannot be loosened by hand.

NOTICE
Do not overtighten the +12V terminal to prevent damage to the terminal.
5 Connect the large ring end of the 12-V cable  to the positive terminal on the vehicle battery.

Pairing with a Garmin Navigation Device
You can pair your Garmin PowerSwitch device with a compatible Garmin navigation device.
1 Turn on power to your Garmin PowerSwitch device and place your compatible Garmin navigation device 

within 1 m (3.3 ft.) of it.
2 On your compatible navigation device, open the Garmin PowerSwitch app.
3 Follow the on-screen instructions to complete the pairing and setup process.
The main app dashboard appears. After the devices are paired, they connect automatically when they are turned 
on and within range.

Garmin PowerSwitch Specifications
Dimensions (D x W x H) 75 x 125 x 32 mm (2.95 x 4.92 x 1.26 in.)

Operating temperature range From -25° to 85°C (from -13° to 185°F)

Wireless frequency 2.4 GHz @ 10 dBm

Power input From 12 to 16 V using the included vehicle power cable.

Maximum accessory output 30 A

Maximum system output 100 A

Current draw with all outputs off 3 mA

Water rating IEC 60529 IPX72

My Garmin PowerSwitch will not stay connected
• Verify the Garmin PowerSwitch device is receiving power.
• Verify that Bluetooth technology is enabled on your paired navigation device or smartphone.
• Move the navigation device or smartphone closer to your Garmin PowerSwitch device.
• Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is 
receiving less than 11 V of power (My accessories are not receiving power, page 60).

2 *The device withstands incidental exposure to water of up to 1 m for up to 30 min. For more information, go to www.garmin.com/waterrating.
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My accessories are not receiving power
• Verify that the Garmin PowerSwitch device is receiving power from the vehicle battery.
• Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is 
receiving less than 11 V of power. Outputs turn back on when the device detects more than 12 V of power.

• Verify that all electrical connections are secure and will not come loose while operating the vehicle.
• Verify that each connected accessory draws less than 30 A.

If an accessory draws more than 30 A, the device turns off that output automatically.
• Verify that the total system load is less than 100 A.

If the device detects a system load of more than 100 A, it turns off all outputs automatically.
• Inspect all electrical connections for an electrical short circuit.

Wireless Cameras
Your device can display the video feed from one or more connected wireless cameras (sold separately).

Pairing the Camera with a Garmin Navigation Device
You can pair the camera with a compatible Garmin navigation device. For more information about compatible 
Garmin devices, go to the product page at garmin.com/bc40.
1 Update your navigation device to the latest software.

Your device may not support the BC 40 camera without the latest software. For more information about 
updating the software, see the owner's manual for your navigation device.

2 Install batteries in the camera.
The camera enters pairing mode automatically and the LED flashes blue while the camera is in pairing mode. 
The camera remains in pairing mode for two minutes. If pairing mode expires, you can remove and reinstall 
the batteries.

3 Bring the compatible Garmin navigation device outside your vehicle and within 1.5 m (5 ft.) of the camera 
and turn on the navigation device.
The device detects your camera automatically and prompts you to pair with it.

4 Select Yes.
TIP: if the navigation device does not detect the camera automatically, you can select  > Wireless 
Cameras > Add New Camera to pair with it manually.
The device pairs with your camera.

5 Enter a name for the camera (optional).
You should use a descriptive name that clearly identifies the location of the camera.

6 Select Done.

Pairing a BC™ 50 Camera with a Garmin Navigation Device
You can pair the BC 50 camera with a compatible Garmin navigation device. Go to garmin.com/bc50 for more 
information about device compatibility.
1 Update your navigation device to the latest software.

Your device may not support the BC 50 camera without the latest software. For more information about 
updating the device software, see the owner's manual for your navigation device.

2 Select  > Wireless Camera > Add New Camera.
3 Follow the on-screen instructions to finish pairing and setting up the camera.
After you complete the pairing process with a camera for the first time, it connects automatically to the Garmin 
navigation device when power is applied.
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Viewing the Wireless Camera
 WARNING

This device is intended to enhance situational awareness when used properly. If used improperly, you could 
become distracted by the display, which could lead to an accident causing serious personal injury or death. 
Always view the display at a glance when the vehicle is in motion to avoid becoming distracted.

Select  > Wireless Cameras.

Aligning the Guidance Lines
For the best reference points, the guidance lines should be aligned to reflect the outside edges of the vehicle. 
You should align the guidance lines separately for each backup camera. On some models, adjustment is 
automatically available after pairing a camera.

 WARNING
You must ensure that the guidance lines are properly aligned before using the device and after making any 
camera angle adjustments. Failure to properly align the guidance lines could result in an accident or collision, 
resulting in death, serious injury or property damage.

1 Position the vehicle with one side closely aligned to a kerb, driveway or parking stall lines.
You may want to position the vehicle in the centre of a parking stall and then pull forwards into the next stall. 
This allows you to use the parking stall lines at the rear of the vehicle as reference points for alignment.
The kerb, driveway or parking stall lines should be clearly visible on the device.

2 Select an option:
• From the camera view, tap the screen and select .
• From the camera view, select  > Adjust Video.

3 Drag the circles on the corners of the guidance lines , or tap the arrows until they match the angle and 
position of the kerb, driveway or parking stall lines.
The guidance lines should appear directly on top of your reference points.
The red or orange section of the guidance lines should align with the rear of your vehicle.

4 If necessary, reposition the vehicle with the other side closely aligned to a kerb, driveway or parking stall 
lines, and repeat the alignment process.
You should attempt to keep the guidance lines symmetrical, even if your vehicle is not in perfect alignment 
with the kerb, driveway or parking stall lines.

5 Select  after alignment is complete.
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Installing a memory card for maps and data
You can install a memory card to increase the storage space for maps and other data on your device. You can 
purchase memory cards from an electronics supplier. The device supports microSD memory cards from 4 to 
256 GB. Memory cards must use the FAT32 file system format.
1 Locate the map and data memory card slot on your device (Device Overview, page 1).
2 Insert a memory card into the slot.
3 Press it in until it clicks.

Data management
The device has a memory card slot for additional data storage.
NOTE: the device is compatible with Windows 7 and newer, and Mac® OS 10.7 and newer.

About Memory Cards
You can purchase memory cards from an electronics supplier or purchase pre-loaded Garmin mapping software 
(www.garmin.com). Memory cards can be used to store files such as maps and POIs.

Connecting the Device to Your Computer
You can connect the device to your computer using a USB cable.
1 Plug the small end of the USB cable into the port on the device.
2 Plug the larger end of the USB cable into a port on your computer.
3 From your zūmo device, select Tap to Connect to Computer.
A picture of your device connected to a computer appears on the device screen.
Depending on your computer operating system, the device appears as either a portable device, a removable 
drive, or a removable volume.

Transferring GPX Files From Your Computer
Apple® computers may require additional third-party software, such as Android File Transfer, to read and write 
files on this device.
If you have already created routes that you want to use on your device, you can transfer GPX files directly from 
your computer.
1 Connect the device to your computer (Connecting the Device to Your Computer, page 62).

The device appears as a portable device.
2 On your computer, open the file browser.
3 Select a GPX file.
4 Select Edit > Copy.
5 Browse to the GPX folder on the device.
6 Select Edit > Paste.

Transferring data from your computer
1 Connect the device to your computer (Connecting the Device to Your Computer, page 62).

Depending on your computer operating system, the device appears as either a portable device, a removable 
drive, or a removable volume.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Browse to a folder on the device.

NOTE: for a removable drive or volume, you should not place files in the Garmin folder.
6 Select Edit > Paste.
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Disconnecting the USB cable
If your device is connected to your computer as a removable drive or volume, you must safely disconnect your 
device from your computer to avoid data loss. If your device is connected to your Windows computer as a 
portable device, it is not necessary to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove Hardware icon in the system tray and select your 
device.

• For Apple computers, select the device, and select File > Eject.
2 Disconnect the cable from your computer.

Adding BaseCamp™ Data to Garmin Explore
You can export your BaseCamp data files and import them to Garmin Explore for use with your zūmo device.
1 Export your data from BaseCamp:

• If you are using an Apple computer, see Exporting Data from BaseCamp with an Apple Computer, page 63.
• If you are using a PC, see Exporting Data from BaseCamp with a PC, page 63.

2 Import your BaseCamp data to the Garmin Explore website (Importing Data to Garmin Explore, page 63).
3 Synchronise your Garmin Explore data with your zūmo device (Synchronising Garmin Explore Account Data, 

page 20).

Exporting Data from BaseCamp with a PC
1 Select an option:

• To export all BaseCamp data stored on your computer, select My Collection and select File > Export > 
Export 'My Collection'.

• To export one or more items or a list, select one or more items or a list and select File > Export > Export 
Selection.

2 Enter a name, select a location for the exported file, select the file format and select Save.

Exporting Data from BaseCamp with an Apple Computer
1 Select an option:

• To export all BaseCamp data stored on your computer, select My Collection and select File > Export 'My 
Collection'.

• To export one or more items or a list, select one or more items or a list and select File > Export Selected 
User Data.

2 Enter a name.
3 Select a location for the exported file.
4 Select the file format.
5 Select Export.

Importing Data to Garmin Explore
1 Go to explore.garmin.com and log in to your account.
2 Select the Map tab.
3 Select .
4 Follow the on-screen instructions.
The data syncs to the Tread app and your zūmo device automatically.

Viewing GPS signal status
Hold  for three seconds.
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Purchasing additional maps
1 Go to your device product page at garmin.com.
2 Click on the Map tab.
3 Follow the on-screen instructions.
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